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Why do companies need Zetadocs PDF?

Zetadocs PDF helps Outlook users assemble and deliver business documents as PDFs by email,
eliminating the risk of them being modified by the recipient. By offering access to shared company
documents, any Zetadocs user can quickly merge multiple documents in to a single PDF on company
stationery, reducing the time taken to produce professional documents. Zetadocs archives copies of sent
documents to a central location, ensuring that customer contact is recorded accurately and automatically.

· Secure PDF creation for every user. Zetadocs PDF allows everyone in an organization to create
secure PDF documents, rather than just a select few. 

· Saves time and money. Zetadocs PDF reduces the time and cost associated with producing and
delivering business documents. 

· Helps deliver a better service. Companies can respond immediately to customers with personalized
PDF documents that look good and which automatically incorporate the correct attachments.  

Who is it for?

· Sales and marketing departments. For personalized, well-presented direct mail, proposals, tenders
and quotes. Standard attachments such as terms and conditions can be added automatically to
designated types of document such as sales contracts or quotes.  

· Customer services. For personalized communications across customer databases.  Customer
satisfaction surveys, for example, can be  individualized for each customer.  

· Accounting. Statement runs and invoicing can be completed in minutes, despatching documents
directly from the accounts package and saving hours of envelope stuffing. 

· IT department.  Zetadocs PDF can be deployed quickly and easily whether on individual desktops or
across a network.  It offers a low cost of ownership: updates and patches are downloaded automatically.

Key features

Document Assembly
· Create PDF files from any Windows application that can print. 
· Merge documents from multiple sources, e.g. Word and Excel, or other PDF documents, with the help of

a “what you see is what you get” image of your document. 
· Drag and drop pre-saved company stationery or attachments into your document as you create it.
· Create and merge PDFs from scanned documents 

Document Delivery
· Send PDFs directly to email recipients from within Zetadocs with a single mouse-click.
· Integrate with your Outlook to convert and send attachments from within Outlook automatically
· Combine with Word’s Mail Merge or other report writers to send PDFs singly or in batches to groups of

people.  
· Personalised PDF creation. Use Microsoft’s mail merge function to personalise not only the email

message but also the PDF document for each recipient. 
· Chose to send documents by Fax if this is preferred by the recipient  
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Document Automation
· Specify the properties of certain document types.  For example, quotations may always require

conditions of sale and company stationery.
· Set up templates specifying which stationery, attachment or template to use.
· Specify message body text, subject line and recipient(s) in “to”, “cc” and bcc” fields.
· Apply and modify electronic stationery to document templates; ideal for multi-company environments.

Technical specifications
· Designed for Windows Terminal Services or Citrix Presentation Server™ 4 and 4.5 with Windows Server

2003 (32 bit & 64 bit) or Windows Server 2008 (32 bit & 64 bit) 
· Operating systems supported are Windows Vista Business, Enterprise or Ultimate Edition (32 bit & 64

bit), Windows XP Professional (32 bit)
· Microsoft .NET compatible: requires Microsoft .NET Framework version 2.0 or later
· Uses Active Directory® for rapid and easy deployment with multiple users
· Integrates with Microsoft Outlook version 2003 &

2007, Lotus® Domino® 6, 6.5, 7 & 8, and SMTP
email systems.

· Includes Microsoft Office toolbars compatible with Microsoft Office 2003 and XP.
· MSI installer for deployment onto desktops from a single, central location using Windows Group Policy
· Windows XP-style update service enables simple and fast roll out of new versions and updates
· Scalable to hundreds of users per installation
· Server based attachments, PDF libraries, letterhead designs and document templates for collaborative

working across teams
· Creates PDF files supporting Acrobat 1.2, 1.3, 1.4 and 1.5 standards which are readable using free

Adobe® Reader® software

How to install Zetadocs PDF

The following instructions will guide you step-by-step through the installation of Zetadocs PDF on your PC.

Note:  you will need to have the Microsoft.Net framework installed on your computer.  If you do not have
this, Zetadocs will guide you through the process of obtaining and installing a free download via the
Internet. 

Installation time. 
· Zetadocs PDF:  2 – 3 minutes
· Microsoft.NET:  approx 10 minutes.
Step 1:  Log on to your PC as a user with local administrator rights.

Step 2:  Download the Zetadocs PDF evaluation version from:

 http://www.equisys.com/products/trials.html

The installation wizard will start:
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Step 3: If you do not already have Microsoft.Net on your computer, the Installation Wizard will guide you
through this process.  You may need to restart your computer when this is complete.

Step 4: The Installation Wizard will step you through the installation of Zetadocs PDF. Follow the
instructions on screen when asked what type of installation you require, select Evaluation Install

Step 5: Click Finish when prompted.   

Step 6: The Installation Wizard will return you to the menu.  Select Exit program.  

The installation process for Zetadocs PDF is complete. 

Registering your Evaluation version

For an evaluation installation you are required to register Zetadocs PDF to begin using the application. Until
you have registered, starting either the Zetadocs Client or Zetadocs Configuration program will result in
being prompted for your company name to begin registration. 
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Step 1: Enter your company name and press OK. This will open the Zetadocs PDF Online Registration
Page in your web browser and open the Zetadocs Configuration program on the “Licensing and
Registration” tab. 

Step 2: Fill in the remaining fields on the online registration page and hit Register:

 

You will receive an email with your registration code within a few minutes. 
 
Step 3: Once you have received your registration code, start up the Zetadocs PDF configuration program,
and enter the Licensing and Registration screen: 
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Step 4: Press the Set button and the Registration code dialog will be displayed: 

Step 5: In this dialog enter the registration code that was sent to you at the email address you specified in
the registration form. 
Step 6: Press the OK button to register your system. 

If the registration is successful, the configuration will be saved automatically, the following message will be
displayed:
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Using Zetadocs PDF 

This tutorial will walk you through the basic functions of Zetadocs PDF.  Further tutorials and more detailed
help are available through the Help menu in Zetadocs PDF itself and from the website at 
http://www.equisys.com/products/zetadocs/training.aspx.

Zetadocs PDF allows you to create a PDF document that you can send using Microsoft Outlook from
almost any Windows program.  This tutorial will introduce you to the basic features of Zetadocs PDF. 
Using some of the documents created on installation, you will:
· Print a document from Word
· Apply stationery and an attachment
· Apply templates
· Send the documents as PDFs automatically from Outlook 

You will then be able to replicate this functionality with your own business documents stored on your
network. 

Create a PDF document

Open the sample letter (c:\program files\samples\sample letter.doc) in Microsoft Word.  Zetadocs PDF will
have installed a button on your standard toolbar as in the screen shot below.  Click on this button. 
Alternatively, choose “File | Print” and select the Zetadocs PDF printer from your printer dialogue box and
press OK.  

· The Zetadocs PDF window will open automatically as Zetadocs PDF creates your PDF and you will see
your new document in the Reading Pane.  This may take a few seconds as the Zetadocs PDF
application loads. 

· You can now send your document to a recipient in your Outlook address book, or you can apply
stationery.

Apply stationery

This allows you to create your document on a particular type of stationery – most commonly company
letterhead or continuation paper.

· Ensure that your principle document is displayed on the central screen in the Zetadocs PDF window.
The window on your right is the Accessories window.  If this is not already displayed, click Accessories
on the Zetadocs PDF toolbar. This button will open and close the Accessories Window.  

· Select the Zetadocs PDF folder and Stationery from the Type drop down list.  Highlight the WM
stationery.  A thumbnail preview appears.  
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· Click the Add button or drag the stationery to your document in the Document Explorer window.  The
stationery is merged with your document.

Add an attachment

An attachment will form part of the final PDF you create.  In this case, the example is of company terms
and conditions.

· From the Accessories window, select Attachments from the Type drop down list, in the Zetadocs PDF
folder.  

· Highlight WM Attachment.  
· Click the Add button or drag the attachment to your document in the Document Explorer window.  The

attachment will be added to your document.  The image in the Thumbnail View is also updated, showing
all pages of your document.  You can click on any of these pages to view them in the Reading Pane.
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Address the document

Select the document name which appears at the root (highest up on the screen) of the document tree in
the document explorer window. The display in the reading pane changes to an email form.  

· Write and address your email using the form as you would with Outlook.  
· On the Zetadocs PDF toolbar, click Send. An Outlook email form will pop up that contains your message

and your PDF attachment. You can now send your PDF as an attachment to anyone in your Outlook
address book.

Create a document template

A document template allows you to specify a set of rules for every new PDF created with it.  These can
include the application of particular stationery and attachments as well as the specification of email options.
This example demonstrates how a sales template may be set up to ensure that headed paper and sales
conditions are always included and that a copy of each email is sent automatically to the sales manager.
 
· Open Zetadocs PDF and select the Tools > Create Document Template... option. The Document

Template Wizard will start. Select the Next option to continue.
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Add stationery to your template
· You will now be asked if you wish to specify any stationery. If you leave this blank no special stationery

will be applied.
· Select the stationery entitled WM Stationery. A preview of this stationery appears as a thumbnail. 
· Click on the Add button. The WM Stationery you selected will be listed in the Selected Stationery box

as shown below. 
· Click on the Next button when you are ready to proceed.

Add an attachment to your template
· Available attachments are displayed in the top-left box. You can select an attachment by highlighting it. 
· Select the attachment entitled WM Attachment. A preview appears as a thumbnail. To add this

brochure as an attachment, click on the Add button. The WM Attachment will be listed in the Selected
Attachment box as shown below. 

· You can add more attachments if you have them available.

Specify message options for your template
· Enter your subject and message body and select a recipient either by entering their SMTP email

address or clicking To:, Cc:, or Bcc:, and selecting a recipient from your Outlook address book.
· When you are ready to proceed, click Next >

Review the template
The summary screen is the final screen in the Wizard and lists the settings you have chosen. 

· Save this document as Sales Quotation. You can save your template locally for your own use or in a
shared network location so that other network users can access it
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Note: if saving a template to a shared location on the network, you must ensure that the PC where you
store the template has appropriate access to any stationery or attachments you have used.

· Click Finish when you are ready to proceed.

Apply the template 
· Open the document entitled Sample Letter.doc (c:\program files\zetadocs pdf\samples) using

Microsoft Word. 
· Print the document to the Zetadocs PDF printer. The Zetadocs PDF software will display your

document.  
· Click on the Accessories button, or choose View | Accessories Window. Selected the folder where

you saved your template, and select Templates from the Type drop down.
· Your template entitled Sales Quotation will be visible. Highlight it and click Add. The stationery and

any attachments will automatically be added to your document. If you included any email sending
options such as a message body, or subject line, it will be visible as shown in the screen below

· Click Send to deliver the document.

Add a Command to a document

Documents can be automatically sent directly from the document you are working in by adding Embedded
Commands to the document. By adding the command you can automatically apply the stationery,
attachments and email details that you set up in a template every time the document is sent. This is done
without having to use the Zetadocs PDF interface, therefore saving you more time. This example shows
how to apply the Sales Quotation template as a command.

· Open the document entitled Sample Letter.doc (c:\program files\zetadocs pdf\samples) using
Microsoft Word. 

· Click on the Accessories button, or choose View | Accessories Window. Selected the folder where you
saved your template, and select Templates from the Type drop down.

· Your template entitled Sales Quotation will be visible. Right click on it and select Copy Automation
Command. 

· Go back to the Sample Letter.doc and paste the command into the document. Then highlight the
command and change to white font so that it will not be visible in the final PDF. 

· To send the document and add the stationery, attachment and email details automatically, simply select
the Zetadocs PDF button from the tool bar.  

Create your own stationery and attachments

You have now learnt about some of the Zetadocs PDF functionality using the sample documents that come
with the product. The next step is to create your own stationery and attachments to be used for document
production. You can then merge these to PDFs that you create and incorporate them in templates. 

Create your own stationery
· Open Microsoft Word and create a new document. 
· Select the image that you want to use as your company stationery. This can be a range of file formats,

e,g.bmp, .gif, .jpeg
· Add the image your document using the Insert > Picture > From file. This will allow you to locate any

image file that is compatible with the Microsoft Office suite.
· Place the image at the top right of your document window using the right justification option and

adjusting the margins.
· Print your document to the Zetadocs PDF printer.
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· Select the document that you have just printed.
· Use the reading pane to check the layout of your stationery.
· If you are happy with the look of your stationery, then the stationery can be saved using the Save as

Stationery option found in the File menu.
· This will open the Save As menu window, and allow you to choose a file name for your stationery.
· Select the Save option to save your stationery.
· This stationery can now be applied to any documents printed to Zetadocs PDF. To test your stationery

simply apply it to the sample document.

Creating Attachments
· Open the document you wish to become an attachment, for example a brochure or price list.
· Print the document to the Zetadocs PDF printer.
· Select the document that you have just printed.
· Use the reading pane to check the layout of your attachment.
· Add any stationery you wish to have present within your attachment.
· If you are happy with the look of your attachment, then the attachment can be saved using the Save as

Attachment option found in the File menu.
· This will open the Save As menu window, and allow you to choose a file name for your attachment.
· Select the Save option to save your attachment.

This attachment can now be added to any documents printed to Zetadocs PDF. To test your attachment
simply add it to the sample document sample letter.doc.

Zetadocs PDF Outlook add-in

The Zetadocs PDF Outlook add-in allows users to quickly convert Office attachments to PDF from within
Microsoft Outlook. The Zetadocs PDF Outlook add-in converts attachments at send time, allowing users to
follow their usual workflow. Installed as part of the main Zetadocs PDF install process, the Zetadocs PDF
Outlook add-in uses the core functions of Zetadocs PDF to allow you to quickly convert Office attachments
to PDF. Zetadocs PDF Outlook add-in gives you the option to convert your attachments into a single PDF
or into individual PDFs, and also to compress your attachments into a zip file.

Convert an attachment
Any Office® based attachment that you add to an email message can be converted into either a single
PDF or multiple PDFs using Zetadocs PDF.  

· Attach your document to your email message in the usual manner.
· Start the Zetadocs PDF Wizard:

If your default options have been set Convert attachments on Send, the Zetadocs PDF Wizard will start up
automatically if it detects an attachment has been added to the message.
If your default options have not been set to Convert attachments on Send, you can manually start the
Zetadocs PDF Wizard by selecting the Convert Attachments button.

The Wizard will display the attachment that you have added to your message:  
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All attachments that are suitable for PDF conversion will be selected in the Select Attachments window.  
· Highlight an attachment by clicking your mouse on it.
· Use the up and down arrows to change the order of your attachments

Change the order of attachments
If you have selected multiple attachments, you can change the order in which they will appear after PDF
conversion.

1) Attach your document to your email message in the usual manner.
2) Start the Zetadocs PDF Wizard:

i) If your default options have been set Convert attachments on Send, the Zetadocs PDF Wizard will
start up automatically if it detects an attachment has been added to the message.

ii) If your default options have not been set to Convert attachments on Send, you can manually start
the Zetadocs PDF Wizard by selecting the Convert Attachments button.

The Wizard will display the attachment that you have added to your message.
All attachments that are suitable for PDF conversion will be selected in the Select Attachments window. 

3) Highlight an attachment by clicking your mouse on it.
4) Use the up and down arrows to change the order of your attachments

Convert multiple attachments into a single PDF
If you have more than one attachment that you want to attach to your email message, you can have the
option to combine your attachments into a single PDF document or to create individual PDF documents of
each attachment.  This page deals with how to convert all your attachments into a single PDF.
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Any Office® based attachment that you add to an email message can be converted into either a single
PDF or multiple PDFs using Zetadocs PDF.  

1) Attach your document to your email message in the usual manner.
2) Start the Zetadocs PDF Wizard:

i) If your default options have been set to Convert attachments on Send, the Zetadocs PDF Wizard
will start up automatically if it detects an attachment has been added to the message.

ii) If your default options have not been set to Convert attachments on Send, you can manually start
the Zetadocs PDF Wizard by selecting the Convert Attachments button.

The Wizard will display the attachments that you have added to your message.

3)   Choose the order in which you wish your attachments to appear within your PDF.
4) Select the Convert attachments into a single PDF option, and type the name of your new PDF in

the text-box provided.
5) Click the Next button to start converting your attachment.

When conversion is complete, a new window will open, allowing you to view the PDF document you have
created:

6) You can scroll page by page through the thumbnail view of your PDF, by selecting the document
and using the arrow buttons underneath the thumbnail view to move between pages.

7) To view the created PDF, select the Preview button, and your PDF will be opened in Adobe
Acrobat.

8) When you are happy with your created PDF, select Finish to exit the Zetadocs PDF Wizard and
attach your created PDF file to your message.
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Combine multiple files 

Zetadocs PDF allows you to quickly merge multiple Office documents into a single PDF, even if they are
different files formats. You can do this from within the Zetadocs PDF user interface or from within
Document Explorer. 

Starting the Combine files wizard from within Zetadocs PDF
Using the Combine button that is present both in the toolbar at the top of your screen and also in the file
dropdown you can start the Zetadocs Merge wizard:

Starting the Merge wizard from a Document Explorer window

If none of the documents you wish to merge are present within Zetadocs PDF, you may find it more
convenient to send the documents directly into the Combine wizard.

To do this:

Step 1: Browse to your document location, and select all the documents you require.
Step 2: Using the right mouse menu, select the Send To >  Email to Zetadocs PDF... option.

Step 3: The Zetadocs Combine files wizard will start up with all documents that you have selected loaded:
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Using the Combine files wizard
Step 1:  On the first page of the Wizard, add all the documents that that you wish to merge into your
document using the Add... button.
Step 2: Rearrange the order of your documents if required by selecting a document and moving it's
position using the arrow keys.
Step 3: Use the options at the bottom of the screen to choose whether you want to combine your
documents to a new PDF or an existing Zetadocs document.

a) If you have decided to create a new document, by default, the title will be that of the first document
in your list.  If you wish to change this, type the required name in the box provided.

b) If you have decided to combine your documents to an existing Zetadocs PDF document  select the
document from the drop-down list next to this option.

Step 4: When you are ready to continue, click the Combine button and your documents will be processed.

When your document is ready it will be displayed in the document explorer window, allowing you to edit it in
normally before sending. 

Combine multiple documents

Documents appearing in the Zetadocs document explorer window, can be combined using the Combine
Zetadocs documents command to create a single document.  

To combine multiple documents:

Step 1: Print your documents to the Zetadocs PDF printer so that they appear in the Zetadocs document
explorer window.

Step 2: Select the Combine option from the Zetadocs toolbar and click “Combine Zetadocs documents”.

Step 3:  From the Combine Zetadocs documents dialog, click the ‘Add’ button.  The Add Documents dialog
lists all documents that exist in the document explorer window.  You can select multiple documents by
holding CTRL and clicking on them.  When you have finished your selection, click ‘Add’.

Step 4: The documents you have selected appear in the list box as shown in the screen below.  You can
specify the order to combine the documents using the Up and Down arrows or reverse the current order by
clicking ‘Reverse’.  
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Step 5: Finally, you can choose whether to combine the selected documents to an existing document in the
document explorer window, or to create a new Zetadocs document.  

Scan to PDF 

Zetadocs PDF integrates with  scanning equipment  so that  copies of  paper  documents  can  be combined
into a single PDF. Once in the Zetadocs PDF user interface, you can add stationery and attachments, or
combine the scanned document with other files. 

To do this:
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Step 1: Use the scan button available in the client,  either from the top toolbar, or from the file menu: 

 Scan button on main toolbar
Scan button available

from the file menu

Step 2:
a) If a scanner has been detected, the software relating to that scanner will be automatically started

allowing you to set your scanning options as standard:

An example of scanning software options

b) If more than scanner is detected, all scanners will be displayed in a list to allow you to select the
most suitable:

multiple scanners being displayed
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Step 3: Use your scanning software to capture the scanned image.
Step 4: Close your scanning application widow 

Your document will appear in the document explorer window allowing you to add attachments, stationery
and templates to your scanned document before sending.

Send documents by Fax 

Zetdocs PDF allows you to send documents via fax, as well as PDFs by email, from a single user interface.
Zetadocs PDF enables you to send the document by the recipients preferred medium, therefore improving
customer service whilst still maintaining document security. You will need the Zetafax client to enable this
functionality. Please contact Equisys for further details. 

To send a fax:
Step 1: On the addressing dialog you will notice there is a fax addressing line:
Step 2: To add your fax address you can either:

(a) Add your fax address by hand using the following format:
recipient_name@recipient_company@fax_number

for example:

Jim Jones@Jones Construction@555 456 6666

(b) Add your fax address using the fax addressing wizard:
Enter the name of the person you wish to send a fax to, their company name and their fax

number into the boxes provided and click Add to list.  Select OK when you are ready to return
to your message.

Step 3: Select the Fax Options button to choose your Coversheet, Letterhead and sending options.  

Note: Any fax options will only be applied to messages sent to fax recipients.  

Step 4: Include any text that you wish to be displayed on your Coversheet in the message body.
Step 5: You can view the appearance of your fax at any time by selecting the Fax Preview button on the
Zetadocs toolbar:
Step 6: When you are happy with your fax message, click Send to send your message.



 21

© 1991 - 2008 Equisys Plc

Index
- A -
Add an attachment     8

Address the document     9

Apply stationery     7

- C -
Create a document template     9

Creating a PDF document     7

- G -
Getting Started     3

- I -
Installation     3

- K -
Key Features     2

- R -
Regitration     4

- S -
System requirements     3

- T -
Technical information     3

- U -
User Groups     2

Using Zetadocs     7, 11, 12, 15, 18, 20

Add a     11

Add an attachment     8

Address the document     9

Apply stationery     7

Create a document template     9

Creating a PDF document     7


	Why do companies need Zetadocs PDF?
	Who is it for?
	Key features
	Technical specifications
	Install Zetadocs
	Registering your evaluation version
	Using Zetadocs PDF
	Create a PDF document
	Apply stationery
	Add an attachment
	Address the document
	Create a document template
	Add a Command to a document
	Create your own stationery and attachments
	Zetadocs PDF Outlook add-in
	Combine multiple files
	Combine multiple documents 
	Scan to PDF 
	Send documents by Fax 


